Contents
Notes ............................................................................................................................................. 5
Preface ........................................................................................................................................ 6
Introduction .................................................................................................................................. 6
What Remains the Same ............................................................................................................... 6
What’s New and Different ............................................................................................................ 6
About the Warehouse .................................................................................................................... 7
The CeDAR Website ..................................................................................................................... 8
Logging into Cognos Analytics ................................................................................................. 9
  Additional Ways to Enter the Information Warehouse ............................................................ 9
User Experience ............................................................................................................................ 10
The Welcome Portal ..................................................................................................................... 10
My Content, Team Content, Packages, and Folders ................................................................ 12
Recent Items ............................................................................................................................... 12
Search and Find Content .............................................................................................................. 13
  Narrow Your Search with Filters ............................................................................................ 13
  Save Your Search ................................................................................................................... 13
Navigation ..................................................................................................................................... 14
  Welcome Menu (Page Switcher) ............................................................................................ 14
Set as Home .................................................................................................................................. 14
More Button .................................................................................................................................. 14
Home Button – Gray Navigation Toolbar .................................................................................. 15
Notifications ................................................................................................................................. 15
Personal Menu ............................................................................................................................ 16
Exploring Content ....................................................................................................................... 16
Viewing and Interacting with Content ....................................................................................... 17
  The Action Menu .................................................................................................................. 19
Report Properties ....................................................................................................................... 19
Password Protecting PDF Documents ....................................................................................... 20
Prompts ......................................................................................................................................... 21
Drill Through Reports .................................................................................................................. 22
Report Options ............................................................................................................................ 22
Subscriptions ............................................................................................................................... 22
  Subscribing to Reports ........................................................................................................... 22
Notifications ............................................................................................................................... 23
Icons Used In This Guide

**Information:** This icon serves as a general “FYI” and is used to provide you with background information that you may find useful.

**Alert:** This icon is used to signify a warning or alert that something involved in the current process could potentially cause a problem.

**Note:** This icon is used to inform you that there could be something here worth paying attention to.

**Try It:** This icon demonstrates that it’s time to try to perform an action yourself. Follow the steps provided and give it a try.

**Stretch Your Thinking:** This icon encourages you to stretch your thinking with both introduced and unintroduced material.
Preface

Implemented at Princeton in 2005, the Cognos BI suite integrates with many Princeton applications to provide business intelligence services, including reporting abilities to PeopleSoft HR, PeopleSoft Financials, and PeopleSoft Student, as well as other non-PeopleSoft related applications including Labor Accounting, Time Collection, and University Housing. The Information Warehouse utilizes Princeton’s LDAP environment to provide authentication.

Specific departments within the University community take ownership and govern the data in the Information Warehouse. To acquire access to a specific package, please contact the appropriate package custodian. For further information about accessing and/or using data, please refer to http://cedar.princeton.edu/access-use-data.

- Information in Princeton’s Information Warehouse is 24 hours old
- Cognos Analytics works with the following browsers:
  - Chrome
  - Firefox
  - Internet Explorer (preferred)
  - Safari
  - Microsoft Edge (not-compatible)

Only fictitious Information Warehouse data sets in CeDAR’s Training Data Package are used in this guide.

Introduction

Welcome to Cognos Analytics! Princeton University has upgraded to the latest release of IBM’s Cognos BI tool, (Cognos 11.1.7). IBM provides a modern, user-focused interface, which emphasizes a self-service user experience while delivering strong BI capability.

This tool features a consistent user experience while moving from capability to capability. The portal, the reporting tool, and the dashboard/story tools are within a single browser tab.

What Remains the Same

For those who have been working with Cognos, many features remain the same including:

- Working remotely you still need to VPN in
- Left vertical gray navigation bar
- Top horizontal orange tool bar
- Your data, folder directories, report names, prompts, run formats, schedules, security
- Content in Team Content and My Content
- Ability for users to interact with data upon running reports (contingent on security permissions)
- Ability for users to upload data (contingent on security permissions)
- Dashboard and storyboarding functionality (contingent on security permissions)
- A new link directly to the Tableau server for those who have access to Tableau

What’s New and Different

For those who have been working with Cognos, some new features include:

- IBM Carbon open source design system for products and digital experiences. With the IBM Design Language as its foundation, the system consists of working code, design tools and resources, human interface guidelines, and a vibrant community of contributors.
- Improved search functionality
- Enhanced schedules and subscription window for report consumers
About the Warehouse
The Princeton University “Information Warehouse” is the reporting data repository available to the Princeton Community. Consumers of this data can access reports through the IBM tool, Cognos Analytics. Data sets inside the Information Warehouse (IW) accurately represent information in the corresponding source, or source system. On a daily basis, all source systems (such as PeopleSoft Financials or Time Collection) feed their data into IW reports. Information within the IW is considered twenty-four hours old.
The CeDAR Website

CeDAR's website communicates information to the Princeton Community, as it pertains to the Information Warehouse (IW) including:

- Who to contact to gain access to reports
- Cognos outages and downtimes
- Data loading discrepancies

The URL to the CeDAR site is https://cedar.princeton.edu.

The Information Warehouse can be accessed several ways:

- Click the link at the top of the CeDAR homepage to Enter the Warehouse.
- Click the IW & Tools tab on the homepage menu: https://cedar.princeton.edu/iw-tools. This will lead you to a list of URLs to choose from.
- Choose Information Warehouse from the shortcuts listed on the right navigation of the homepage.

Recommended: Bookmark the URL for the Cognos IW_PROD environment.
Logging into Cognos Analytics

To log into Cognos Analytics (the Information Warehouse), choose any of the methods on the previous page. You will need to authenticate with a valid Princeton NetID and password to enter the Warehouse.

 ![Central Authentication Service](image)

Logging into the Information Warehouse from an offsite location (off of the Princeton Network) will require you to use a Princeton Secure Remote Access (SRA/VPN) Connection.

Additional Ways to Enter the Information Warehouse

In addition to logging in via the CeDAR website, users enter the Warehouse in several other ways. Reports can be accessed through external links, PeopleSoft or STRIPES, and/or bookmarked/favorited URLs. Reports are frequently accessed directly from the Princeton Prime Financials Reporting tile found on [www.princeton.edu/prime](http://www.princeton.edu/prime).

Finance and Treasury offers additional reference materials (guides, step by steps, and videos) for ease of navigation and convenience.


If you have any questions or concerns you can contact the Financial Service Center.
User Experience

The interface allows for consistent experience as a user moves from viewing content to creating advanced reports and dashboards. All users work within the same interface with their respective security permissions.

The Welcome Portal

The Content Explorer is also called the Welcome Portal. This is where everything happens. From the Welcome Portal you will run reports, search for content, view content, open dashboards, stories and other items, upload files, check your notifications, and set your preferences and home page.

If you should see these glowing green/blue dots, they are called coach marks (or hints). They are there to help guide you through the portal as you get started using Cognos Analytics.

When these hints are no longer necessary, you can easily turn them off by clicking one of them and selecting Turn off Hints.

Clicking the X on the top right corner will turn off that particular hint.
You can turn all hints on or off from My Preferences under the Personal Menu and checking/unchecking the box next to Show hints.

Depending upon your screen’s resolution you may or may not see additional information beside the icons on the Left Navigation pane. Increasing or decreasing your zoom level will determine whether the Left Navigation pane is expanded or collapsed.

The Welcome Portal offers tiles for quick access to work with items you’ve recently used. By default, you will see six live tiles. If you wish to see more recently used objects listed, click the Show More link. Clicking the More Button will reveal an action menu and allow you to take additional actions.
My Content, Team Content, Packages, and Folders

The Left Navigation pane includes tabs for:

Home - is your Welcome page and recently viewed reports area.

Search - allows you to search for packages, folders and reports.

My Content - is a user’s secured area to any content saved there. Only the user can access this area. Reports saved to this area can be modified. You can create new directory folders here. You can also copy reports or save report views to this folder.

Team Content – contain reports or other objects that you have permission to view or access. You cannot modify or personalize reports in these folders.

Recent - This fly-out window shows up to 20 recently viewed items.

Recent Items

Click directly on a report name to Run it or hover over a report/object name to reveal the More button to reveal a list of actions.
Search and Find Content

Whether you’re looking for reports, dashboards, stories, data, files, folders, packages or other items, you can find any object you’re looking for by opening your My Content or Team Content folders, or by checking your Recent list. However, the Search is a quick, easy way to find exactly what you’re looking for.

To find items, type keywords into the Search field. As you type objects that meet your search criteria will begin to populate below the search window. You can also search for text including table or column labels, XML report specifications, URL items, shortcuts, templates, and more.

**Search does not return results for content that is archived. You can access archived content from a report that is listed in one of your folders.**

Narrow Your Search with Filters

If your search returns too many results, you can click the Filter icon to narrow your criteria.

*The option to filter is only available after you perform an initial search.*

Save Your Search

After you search and the results are listed, you can Save your search for future use. If filter options were included in your search, these options are also saved and listed under Saved Searches.
The option to Save is only available after you perform an initial search.

Navigation

The user interface affects how you move around in the tool. Here are some navigation tips!

Welcome Menu (Page Switcher)
The Cognos Analytics Welcome Portal is the default Home page. Clicking the drop-down on the Welcome Menu/Page Switcher and selecting Welcome will always return you to this landing page. By default it is your Home Page.

Set as Home
If you prefer, you can make other content (like reports or dashboards) your Home Page.
Click the More button on the application toolbar and select Set as home.

More Button
You are encouraged to click the More button any time you see it, especially as you get used to the user interface. Depending on where you are in navigation, capabilities under the More button may change.
Home Button – Gray Navigation Toolbar

The Home button will return you to your home screen in a single click. This is a more direct route to your home page than using the switcher if you have chosen a new home page.

You can switch your home page from the Welcome Portal to a report or dashboard.

Cognos Analytics offers the ability to have multiple objects open at the same time (in the current session) making it easy to quickly switch between them. Once a report is run, it will remain open in the Welcome tray.

You can close objects that are open in the tray by clicking the × to the right of the object name.

Clicking back to an open report from the tray (or list of live tiles) will not “re-run” the report or allow you to choose new prompts. It will only return you to the report’s last generated output. If you need to re-run your report, you need to reset your prompts or close the active report from the Welcome tray.

Notifications

Alerts are indicated as numbers next to the Notification (bell) icon. As subscribed reports finish executing, the number of alerts will increase.
**Personal Menu**

Use this area to adjust settings related to you as the user, to change preference settings, to easily make any modifications to your schedule and subscriptions, and to logout.

**Exploring Content**

The fly-out menu lets users explore content within their folder(s) as well as perform other administrative tasks depending on permissions.

Hovering over a report (or other object in the content pane) will reveal the **More** ellipsis button. The **More** ellipsis button provides an Action menu, which houses many of the tasks you can perform for that particular report/object.

Clicking around and exploring is the best way to become acclimated to the tool, as well as discover how things work in the user interface.

Use the breadcrumbs to navigate within the content and get out of a buried destination within your folder directory.

By clicking the **Sort** button (up/down arrows), you can sort content in ascending or descending order by name or last modified date.
Use the Filter button to narrow the contents viewed in the pane.

Resize the content pane by clicking and dragging the two small lines on the border of the pane to the desired location.

**Viewing and Interacting with Content**

When you find a report you would like to run, you have several options:

(A) Navigate to the desired report from My Content or Team Content on the Left Navigation menu and click directly on the report name.

(B) Hover over the desired report and click the More button to the right of the report. Choose Run as and select a method to run the report to a specific output type.

(C) If you’d like to run a report that you’ve recently worked with, click in the white space of the live tile on the Welcome Portal.

(D) Click the More button on the bottom right of the live tile.

(E) Navigate to a report via the Recent icon on the Left Navigation menu.

*Once a report is opened in a current session, it will remain open in your Welcome Menu/Page Switcher and held in memory until you close it (or the session). Clicking on an already-opened report from the live-tiles or Welcome Menu will launch the report with its last generated output.*
After you run a report to HTML, you can change the format of the output by selecting the Run as button in the More (…) pull down menu, and choosing a new output from the list that appears in the menu. This will re-run the report with the prompts that have already been selected.

To run the report with different prompts while in Edit mode, select the Run button (orange toolbar) and select Reset prompts and run from the pull-down menu. If you click the Run button without resetting your prompts the last prompt selections will be used to run your report.
The Action Menu

By right-clicking a report or by clicking the More button to the right of the report name, an Action Menu will appear. Depending on your security access, you may not see everything in this menu.

Run as: Allows you to choose from a list of desired output and to run directly to it. Also allows for the option to Run in background.

Edit report: Opens your report in authoring tool allowing you to make changes/edits to the original report (Report Authors only).

Create report view: Creates a report view of the report in your My Content. Usually used to create a dynamic copy of the report for scheduling.

View versions: Displays any previously saved report output.

Create a new job: Creates a new job to run the report on a regular basis.

Share: Copy link to share content with other users

Copy or move: Copy or move a report to another destination within Cognos. The user must have write access to the other destination. A user can copy anything to their My Content area.

Create shortcut: Used to create a shortcut of the report in My Content.

Properties: Displays the report owner, when the report was created and last modified, and reveals the report description, if applicable.

Report Properties

To get to the Properties of a report, navigate to the report, click the More button to the right of the report name to reveal the action pull-down menu and select Properties.

The Properties pane will open. Hover over the report title or the report description to reveal the Edit (pencil) icon. Click the icon to edit.
The **Report** Tab allows you to change default run formats and set prompts for the report.

<table>
<thead>
<tr>
<th>General</th>
<th>Report</th>
<th>Schedule</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Training Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prompt values</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prompt for values</td>
<td>![Check box]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current values</td>
<td>![Set values]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Schedule** Tab allows you to create a new schedule for a report or update an existing one.

**Password Protecting PDF Documents**
To control the ability to alter or manipulate PDF documents, you have the ability to password protect them.

- Navigate to the **Properties** of the report.
• From the **Report** tab, click the drop-down arrow beside **Report options**.
• Then click **Set PDF Options**.

• Check the box next to **Requires a password to open the report**.
• Set and confirm the password.

**Prompts**

Many of our reports have a prompt page that we see prior to the reports execution. This helps make reports more versatile for more users. It also helps the report process faster by limiting the amount of data coming back from the database.

• Prompts can be on one or more pages.
• Prompts can be optional or required. An asterisk * indicates that the prompt is mandatory.
• Finish/Submit/Run buttons are grayed-out until a mandatory prompt is selected.
• Prompt properties can include single or multi-value selection.
• Ctrl+click to select multiple values within the prompt box.
• For convenience, some prompts have Select all and De-select all links below the prompt.
• All prompt pages contain a Cancel, Submit, Finish, Run, or OK button to either cancel or execute the report.
• If prompts are optional and none are selected, the report may take longer to complete.
• Prompt pages can have different looks. Report Authors have the ability to create designs and layouts based upon their best use choices for the data and report.
Drill Through Reports
Some reports may contain drill through links. A drill through is a capability which allows users to see more specific details of a general report by opening an additional (or child) report. Drill-throughs are indicated by a blue hyperlink. When a hyperlink is clicked, a browser window opens to show the drill through (or child) report.

Report Options
There are several options for running a report.

- You have the option to subscribe to the report.
- You can save it as a report view.
- You can run it to several output types (Excel, html, csv, etc.)
- If you are a report author you can make edits to it in the Reporting tool.
- If interactivity mode is turned on you have this new reporting feature.

The options available to you depend upon the type of report and the permissions you have been given in Cognos. Choose the options that best suit your needs for viewing frequency and personalization.

- If you want to see and run a report on a regular basis, subscribe to it.
- If this report location is where you start from each day, you can set it as your home page.
- If you entered prompt and parameter values in the past and you would like to save them so you don’t have to enter them each time you go to run the report, save the report as a report view.
- If you choose to edit the report, the report opens in Reporting with all the tools you need. Depending on the item type, the appropriate actions are available in the viewer.

Subscriptions
Cognos Analytics has simplified the scheduling process through its Subscriptions feature. Subscriptions allows the user to quickly schedule a personal copy (or report view*) of the report.

*See section on Report Views.

The Subscribe feature can only be used after the report has been run. This feature is found on the right side of the orange toolbar under the More button. Subscriptions automatically create a report view in your My Content area. The reports you subscribe to will be delivered to you with custom prompt values and options you have selected.

Subscribing to Reports
End-user schedules are called subscriptions. If you use a report regularly, consider subscribing to it. When you subscribe, you pick the time, date, format, and where you want it to be delivered. The subscription includes all your prompt and parameter values.
The subscription option is available when you run and view a report. Subscribe is not available in edit mode or when you view saved output. If you edit a report, you must save it before you can subscribe to it.

When you subscribe to a report, you are notified each time it is delivered. You will see a numeric alert on the Notifications icon. Click to view any messages, which will contain a link to view the report output.

See section on Notifications for more information.

You can schedule reports for broader distribution. A schedule can be created on objects saved in your My Content folder.

Notifications

Notifications help you stay on top of important data. If you subscribe to a report or a report view, you are notified each time your subscription is delivered. If you view saved output and you want to know when there’s a new version of the report, you can tap the Notify Me button.

The Notify Me button is available from the More button in the application toolbar only when you view a saved output version of a report.

If you request to be notified when someone runs the report, you receive a notification with a link to the updated version.

When you subscribe, if you choose the Save the report on the system delivery option, you receive a notification with a link to the new report version. To view a list of all your notifications, click the Notifications button on the application toolbar.

Schedules

Whether you need to run your report on a daily basis or only every so often, the Scheduling Tool in Cognos Analytics makes it possible to schedule your reports to run automatically, as frequently as you need.

Your original report can only have one schedule associated with it, so it is a best practice to create a Report View (or multiple report views, as needed), which keeps the original report intact and allows you to create as many unique schedules for each report view as necessary. Each schedule can have a different frequency, distribution, and delivery option attached to it. *See section below on Report Views

To create a new schedule on a report or report view:

- Navigate to the report and select the More ellipse (...) button to open the pull-down menu. Select Properties.
- A fly-out window opens with 4 tabs. Select the Schedule tab and click on the + New button.
- Select your criteria in the Create schedule window.

Once you have chosen how often you would like your schedule to run, pay special attention the options that follow:

Format: Choose from a list of output types
Delivery: Choose to send report by email, print the report, or save the report.

Prompts: Set or clear prompt values

PDF: Choose the layout and password protect a PDF (if desired)

- Click Create

Managing Your Schedules and Subscriptions

You can view and manage all of your schedules and subscriptions by accessing them on the My Schedules and Subscriptions panel from the Personal Menu of the application toolbar. You can enable, disable, modify, or delete entries and view their saved outputs or archived versions. If you view the versions, you can also open the version details panel for information such as the run status, error messages, and run time.

Report Views

To create a Report View navigate to your report and open the More pull-down menu. Select Create report view.

Creating a Report View stores the report output in a specified format (html, pdf, etc.), and with specified prompt conditions (if prompts exist). Report View are a combination of a shortcut and a dynamic copy of the original report. So, if you have a report that you want to run with different prompt values, schedules, delivery methods, run options, or output formats, you would create a Report View.

The Report View will always refer to the report from which it was created. Any changes or modifications that are made to the actual report, after creating the Report View, will not be captured in the Report View until you re-run it.

Creating a report view does not change the original report.

If you would like to edit the prompt values for the Report View, open the Properties panel. In the Properties panel for the Report View, you will see a link to the source report.

If the source report is moved to another location, the Report View link is maintained. However, if the source report is ever deleted, the Report View link will break.

Editing Reports

After you have run your report, Report Authors will see an Edit icon in the top left orange toolbar. Clicking this opens Reporting and, allows you to make changes to your report in authoring mode, as long as you have been granted that capability.

See section on Reporting in Cognos Analytics for more information.
Report Output Options

The Run as option under the More (...) button to the right of the report name allows you to choose and run your report to a new desired output format.

<table>
<thead>
<tr>
<th>Format</th>
<th>Features</th>
</tr>
</thead>
</table>
| HTML   | • Default output  
         • Web based and designed for viewing report output on-screen  
         • All pages are displayed and accessible for any report containing tabbed layouts |
| PDF    | • Used for printing and distributing output in Adobe Acrobat Reader  
         • Each page in a tabbed layout report will render its own page |
| EXCEL  | • Previously named Excel 2007 Format  
         • Supports lists, crosstabs, icons, titles, subtotals, totals, and charts  
         • Each page of a tabbed layout will render as its own worksheet |
| EXCEL DATA | • Contains raw data of report  
             • Report formatting (titles, charts, icons, subtotals, totals, etc.) are dropped and data is returned in spreadsheet format  
             • Only the first page of tabbed layouts will appear |
| CSV    | • Exported data which is tab-delimited and can be imported to (or read by other software)  
         • Strings are not enclosed in quotation marks  
         • CSV exports show only the results of the report query  
         • Page layout items, such as titles, images, totals, and subtotals do not appear |
| XML    | • Files that contain the .xml file extension are structured text files that contain custom tags that allow the transmission of files across applications  
         • Running reports to XML will reveal code |

Interactivity Mode

Interactive reports provide interactivity in the report output and will have context sensitive menus that will appear above the object. For example, in a report with Interactivity Mode turned On, you may be able to:

- Change the sort order
- Set or edit filters
- Change the aggregation
- Group a column
- Change the type of data container (i.e. to a chart)
- Save the changes as a new report
- Interact with charts

There are interactive and non-interactive reports. All existing/upgraded reports were brought over with interactivity mode turned off. If necessary, however, these changes can be made at a report level (or at the package level), by your package custodian.
At the discretion of your Package Custodian, reports written in Cognos Analytics may or may not be created with Interactivity Mode turned on.

Report Versions
If you run reports, you will see the latest data from the data source. However, when you view report versions and outputs, such as when a report you subscribe to is delivered, you’re viewing the data that was captured when you saved the version or view of the report.

Report outputs are generated by subscriptions, schedules, multiple formats, bursting, and delivery methods that include save, print, and email. In many instances, you are notified and receive a link to view report output, but you can also view saved and archived versions for reports in your content lists.

To view report versions and archived versions:
For a report in a content list, click the More button next to the report name and then select View versions.

To save a report version:
In the application bar, when you view a report, click the Save button. You may also have the Save as option of saving the report version under a different name or in a different location.

To delete saved outputs for report versions:
For a report in a content list, click the More button. Select View versions and click on an entry in the list. Then select delete.

Deleting removes all saved output formats of the version.

Bursting Reports
Burst a report to distribute its contents to various recipients. Bursting is the process of running a report once and then distributing the report output to recipients who view a subset of the data.

To burst a report:
- Navigate to the appropriate report and hover over it to reveal the More button.
- Click the More button to reveal the Action Menu and select Run as.
• Activate the Run in background button. Slide the button to the right. Notice that this activates the Advanced feature below the report output options.

• Check the box next to the output format you prefer.
• Click the Advanced caret to expand the section.

Choosing Later here will allow you to set a time/date for the report to be bursted.*Current Best Practice!

• Expand the Delivery section to reveal Delivery options.

• You have the option to:
  ➢ Send report by email
  ➢ Print report
  ➢ Send report to mobile device
  ➢ Save report (checked by default)
- Place a checkmark in the box next to Send report by email.
- Place a checkmark in the box next to Attach the report.
- Edit the Recipients and the Subject line.
- You may also create your message here.

- Scroll down and click Done when ready.
- After returning to the Run as screen, click Run.
- Enter Prompts as appropriate.
Reporting in Cognos Analytics - Overview

Cognos Analytics features a consistent user experience with a singular user interface. The portal, reporting, dashboarding, and stories are all inside a single browser tab, creating a common look and feel. The interface allows for a consistent experience as a user moves from viewing content, to editing content, to creating advanced reports and dashboards.

Modifying Existing Reports

Report authors modify existing reports in the report canvas window.

- Run a report.
- Using the Edit icon, you can switch into the authoring interface.
- The Edit icon is used to enter and exit the authoring interface.

![Report opened in Viewer](image)

![Report opened in Authoring](image)
Report Function Mapping
Here are a list of features and functions that will appear in the Reporting interface.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>Save: Save as; Save as Report View; Convert to template</td>
</tr>
<tr>
<td>![icon]</td>
<td>Edit: Toggle between editing and viewing the report/dashboard</td>
</tr>
<tr>
<td>![icon]</td>
<td>Welcome: Page Switcher; Switch between open reports and welcome portal</td>
</tr>
<tr>
<td>![icon]</td>
<td>Page Views: Design; Preview; Structure</td>
</tr>
<tr>
<td>![icon]</td>
<td>Properties: Report level; Run options; Validate options; Burst options; Interactivity; Layouts; References; Formats; PDF; Drill Up/Down/Through…</td>
</tr>
<tr>
<td>![icon]</td>
<td>More: Locked; Options; Layout Components; Conditional Styled; Clear all Parameters</td>
</tr>
</tbody>
</table>

The **Data Pane** and the **Toolbox** are available in **Edit** mode for report authors.

The **Report tab** contains:
- Report overview
- Report pages
- Prompt pages
- Queries
- Classes
- Variables

Content in this document is based on fictitious data sets represented in CeDAR's Training Package.
More Button in (orange toolbar) – Clear all parameters

The More button in the top right Orange toolbar reveals the Clear all parameters function.

Clear all Parameters: Parameter values stored by Cognos Analytics include sign on, validation, and prompt information. Click to clear stored parameter values.

You may want to use an existing report and save it as a new report you are creating. This is a quick way to clear stored parameters from the original report.

Cog More Button Menu (white toolbar)

The Cog More button pull-down menu below the top right Orange toolbar reveals additional options for building/editing/managing your reports.

Open Report from Clipboard: You can open a report specification that was previously copied to the clipboard.

Copy Report to Clipboard: You can copy a report specification from one report for use in another report or environment.

Visual Aids: Visual aids in the work area help you when you are designing your report layout.

https://www.ibm.com/support/knowledgecenter/SSEP7J_10.2.2/com.ibm.swg.ba.cognos.ug_rptstd_fin.10.2.2.doc/t_rptstd_fin_rsfin_visual_aids.html

Find Button: This is one of several ways to search for data packages, report folders and reports. The Find feature does not support searching Queries yet.

Validate Report: Validate your report to ensure that it contains no errors.
When you open a report created in a previous version, it is automatically upgraded and validated.


Validate Options: If there are errors in your report you can view more information here.


Auto Correct: When you are in Page Preview mode, Cognos shows you data as you are creating your report.

If an error occurs and the application cannot retrieve the data, you can use the auto-correct feature to determine if there are any incorrect items in your report. Cognos provides a list of such items, each of which you can then remove to successfully view your report.
For example, if your report refers to member unique names (MUNs) that are either no longer present in the model or inaccessible due to security restrictions, you cannot view your report in Page Preview mode. If the auto-correct feature cannot identify any incorrect items in your report, you can switch to Page Design mode and manually remove or edit incorrect items.

**Layout Component Cache:** This is the location/library where Cognos stores the objects and object attributes (i.e. type, color, size, and, in some cases, behavior) you’ve created. A layout component reference is by far one of the most underrated and underutilized built-in features in Cognos. It allows you to create reusable layout objects within reports and share those objects in other reports.

**Manage Conditional Styles:** You can view, modify, or delete the conditional styles that are applied to your report. You can also define a new conditional style. In the IBM Cognos Analytics- Reporting options, you can specify whether to automatically delete conditional styles that are no longer used in a report.

**Show Generate SQL/MDX:** View the SQL or MDX to see what is passed to the database when you run a report.

**Add Shared Set Report:** When you are working with dimensional data, you can share a set to make it available for inclusion in multiple reports. You must first create a set in a source crosstab report, create a shared set definition, then refer to it in a target report. A shared set definition is copied from one report to another.

**Manage Shared Set Reports:**

**Manage Shared Set References:**

**Show Specification:** Every IBM Cognos report has a report specification that defines the contents and layout of the report. Most of the elements in the report specification schema map directly to an object or property in the Reporting interface. We recommend that you use Reporting to familiarize yourself with the elements and attributes that you can use to author reports. If you want to use the SDK (Software Development Kit) to make the same change programmatically across many reports, you can use Reporting to determine which parts of the report specifications must be changed. After you have determined the required changes to the XML, you can use the SDK to apply the changes to many report specifications. https://www.ibm.com/support/knowledgecenter/en/SSEP7J_11.1.0/com.ibm.swg.ba.cognos.ca_dg_sdk.doc/t_authorin g_report_specifications.html

**Options:** You can set various options that control the appearance and behavior of your report including: View, Edit, Report and Advanced options.

Reporting in Cognos Analytics
Creating a Report - Student Participation Begins Here

In Cognos Analytics you create a report within the browser.

- From the bottom of the left Navigation menu click the **New** button.
- From the pop-up menu, select **Report**.

**Templates and Themes**

Cognos Analytics includes numerous basic report templates and color themes that can be chosen. Within the list of templates, you will find several Princeton standards, Princeton – List, Princeton – Crosstab, Princeton – Tabbed Report.

While you are encouraged to choose a Princeton template, you can also choose from a blank list or crosstab or create your own template.

Select **Blank** report.
You can select the report and click **OK**, or double-click on the **Blank** report.

**Interactivity Mode**

Interactive reports provide interactivity in the report output and will have context sensitive menus that will appear above the object. For example, in a report with **Interactivity Mode** turned **On**, you may be able to:

- Change the sort order
- Set or edit filters
- Change the aggregation
- Group a column
- Change the type of data container (i.e. to a chart)
- Save the changes as a new report
- Interact with charts
This version of Cognos Analytics has **Interactivity Mode** turned **On** by default.
Most Princeton data stewards turn **Interactivity Mode off** as a best practice when report writing.

1) Select **Report** in the **Report** pull-down menu.
2) Open the **Report Properties** window.
   Under **Running & Validating** change Yes to **No**.

**Automatic Group and Summary Function**
In Cognos Analytics, there is an **automatic group and summary** function applied along with totals. With v11.1.7 this option is turned off by default.

Data stewards usually have this functionality turned off at Princeton.
As you become more comfortable creating reports, and depending upon the reports that you create, you may decide to keep this feature on.

**Automatic Group and Summary Functionality – On/Off**

- Check that you are in **Edit** mode.
- Click on the **More (…)** button to open the pull-down menu.
- At the bottom of the menu select **Options**.
- The **Options** window opens.
- Select the **Options Report** tab.
- **Check** the box next to **Automatic group and summary behavior for lists**.
- Select **OK**.

---

Content in this document is based on fictitious data sets represented in CeDAR’s Training Package.
Choosing a Package

A Package in Cognos Analytics refers to the connection to the database for a given data set. It contains a business view of the data that is used to create reports.

- Packages are denoted by an icon resembling a file drawer.
- Reports are never saved to a “file drawer” or package.
- Reports are save to your My Content or Team Content area, depending upon whether you are a report author or package custodian. Package custodians save reports to either area, while reports writers most often save their reports to their My Content area.

The Insertable objects pane includes tabs for the Sources and Toolbox. Check that you are in the Sources tab.

To choose a package, click the blue Select sources button or the Add a source (+) blue button, in the top right of the Insertable objects pane.

A dialog box will open listing a package(s) to which you have been given access.

For this training we will navigate to:
Team Content > Training Data – Reports > Training Data Cognos Package > Training Data.

Select Training Data.
Note: When you select Training Data a message appears. Ignore this message.

Click the Open button when it is activated.
**Insertable Objects Area - Sources**

Take a moment to explore the **Training Data** set. Each folder contains **Query Subjects** that contain data items.

- **Person Bio Data** contains **Person Data**.
- **Student Data** contains **Student Class Data** and **Financial Aid** data.
- **Courses and Classes** contains query subjects for **Department, Dept and Courses, Course Details** and **Term** data.
- For this class you will choose query items for your reports from this data set.

**Adding Data Items to Your Report Page**

1) Click on the **Add Objects (+)** button in the middle of the report canvas.

2) Click the **List** icon.

3) When the **Object and query name** window opens accept the default settings and click **OK**.

4) A **List** box populates the **Report** pane.

5) Navigate to the **Person Data** query subject and open it.

6) Open it and select the first 6 data items.

   You may hold down the **Shift key** and click the first and last data items to select all 6 items.
   Or you may hold down the **Ctrl key** and select each data item one by one.

   **EmpID**
   **Last Name**
   **First Name**
   **Middle Name**
   **Gender**
   **Birth Date**

**Note:** You can also double click on a data item to add it to the report list.

7) To add one data item at a time:

   Drag the items onto the report canvas into the first column body until you see a flashing single lane highway. Then release your cursor.
8) The contextual toolbar should appear above your report canvas. By default it is pinned to the canvas above the report pane. You may unpin the context toolbar by clicking on the Pin/Unpin button, located to the left of the toolbar. If you unpin the toolbar it may move around and sometimes vanish.

9) To do this click the click the Pin/Unpin button, which is furthest left in the toolbar.

**Note:** If you are not working in a maximized window you may not see the entire contextual toolbar. The More (...) button which we use often is located right most on the toolbar. If you can’t see it maximize your window.

10) To the right of the report canvas you will see the Properties pane of the list report you have just created.

11) The Properties button above the window is a toggle that can be clicked to open and close the window.
**Naming and Saving Your Report**

1) Select the **Save as** option under the **Save** button.

2) The **Save as** window opens.
3) Navigate to the **My Content** area where you would like to save this report. You may create a new folder.

4) The **New folder** button is in the top right of the window. Click the button.
5) A new folder line will appear.
6) **Name** your folder. You must select **Enter** on the keyboard to accept the folder name. 
   *i.e. CA Report Writer Class (today’s date)*

   **Do not click the Save button yet!**
7) A note should appear indicating that the new folder has been created. The new folder should appear in the **Save as** window.

8) Select the folder to enter it, and **Name** your new report: **Person Data Report**.

9) Now select **Save** when ready.

10) The window will close and you will return to the report pane.

**Note:** I recommend that you **Save** often while building your report. It is easy to do and if you lose a connection you will not have to back track too far to determine where you are in your report building process. I also save right before I run a report, so if there is a run error I know that my report is saved to that point.

11) The report name now appears above the report window.
Reporting Interface – Home, Insertable Objects, Report Tab
Icons on the interface reveal options and functionality related to report authoring.

When on a report page the gray navigation panel on the left includes the Home and Insertable objects buttons. Above the report page is the Report tab.

In the Report tab pull-down menu you can navigate to the Report, Pages, Prompts and Queries that you are working on within the Report.

You can also access Classes and Variables in this menu.

Classes: Objects in reports are assigned a Cascading Style Sheet (CSS) class that provides a default style for the object. For example, when you create a new report, the report title has the class property Report title text assigned to it. Also, objects inherit the classes set on their parent objects. Create your own classes or modify existing classes in a report to format objects across a report according to your particular needs.

Variables: Most conditional processing is based on report variables. There are three types of report variables: string, boolean and locale.

As we build reports we will be working on the Report page, on the Prompt page, and on the Queries page.

- **Home**: Returns you to your home screen/welcome portal. Your report will remain open.
- **Insertable objects**: Your Sources and Toolbox tabs are located here.
- **Sources tab**: Access your packages, query subjects and data items here.
- **Queries**: Manage your query items and condition explorer here.
- **Toolbox tab**: Your report objects can be found here.
After your Package opens, it is visible in the **Sources** tab. Select the **Insertable objects** button under the **Home** button to access **Source data**, **Data items** and your **Toolbox** (hammer) objects. A blue line appears under the tab that you have selected.

**Sources Tab**
Select the **Sources** tab to view the entire metadata tree.

**Data Items Tab**
The **Data items** in your report are listed as they appear in the query or queries of your report.

**The Toolbox (hammer) Tab**
The toolbox contains report objects such as text, query calculations and graphics.

- Toolbox items are organized into groups.
- You can quickly search for an item in the toolbox.
- Items used most often appear in the **Pinned group** and can be added to or deleted from the group.
  - Right click on the item and click **Add to Pinned Toolbox Items**.

To remove or re-order pinned items, right-click the item, and select your option in the window.
Items in the Toolbox **Pinned** group also appear around the **Add Objects** menu when you create a new report.

To expand or collapse the view of the Toolbox sections click the **List/Icon** toggle button in the top right of the pane.

**Report Tab Pages**

When you select **Pages** in the Report tab pull-down menu you can view and manage existing Report pages, add a **Page set** (page break) or add a **Report reference** (point to an existing report).

Click the **Pages Add** button to create a new page.

When **Prompt pages** are selected under the Report tab the **Add page** button will create a new Prompt page.

**Queries and Conditions**

Use the Report Tab **Queries** button to create or modify queries. You can also add or modify joins, unions, intersections, exceptions and add or modify SQL or MDX statements.

Click the **Queries Add (+)** button to create a new query.

Or from the Toolbox drag or double-click on a **Query** to add it to the query window.
**Report Tab Queries**

Data in a “tabular form” is data that is structured something like a Table in a database. There are “rows” of data that are related to each other, and “columns” that make up the “rows”.

As a rule, each “row” has the same number of “columns”, and the columns are in some specific order for all the rows.

*Right-Click the Query icon in the Query pane to View Tabular Data.*

The report will run showing the tabular data.

---

**Report Specification**

The report specification defines the queries and prompts used to retrieve data, and the layouts and styles used to present the data. It can be found at the bottom of the More (...) button next to the Properties button in the top right white toolbar.

This is a partial view of the report specification.
Exploring Page Views

Reporting in Cognos Analytics offers three views in which you can author reports: Page design, Page preview, and Page structure.

- **Page Design**: In this view, you can see how your report is set up. You will see the report output when you run it.
- **Page Preview**: You view the report page with data. You can edit the report in this view.
  Building your report in this view, or moving between this and Page design view is often quicker than running your report as you build it.

- **Page Structure**: Displays an overview of all of the report objects in your report in a tree structure, organized by page.
  Using a tree structure is useful for locating the objects on a page and troubleshooting problems with nested objects.
Click the **Properties** toggle button to open and close the **Properties** pane.

You can view the different property windows by clicking the **Ancestor** button after clicking into the **Properties** pane.

The **Ancestor** button is located to the right of the context toolbar above the window. The pull-down button reveals the objects in the report.

The **Properties** pane provides a comprehensive view of the data for the report area you are working in. You can make changes to many areas within your report from here. Selecting different objects within the report will reveal different properties.

*Anytime you see the More button (…) click it! You will find more action items behind it.*
On-Demand Toolbar

The On-Demand or contextual Toolbar is context-sensitive. The toolbar options change based on the type of report object and data you have selected.

When you select an object in your report or visualization the on-demand toolbar is activated. From here you can add filters, group query items, apply formatting, and make other changes.

The context toolbar appears at the top of the Report page. You can use the Pin/Unpin toggle button to pin or allow the toolbar to float on the report page. The Pin/Unpin toggle is located to the left of the context toolbar.

When you select an object in the report the context toolbar may change depending upon what functions can be done upon the highlighted object.

When a column body is selected the Filters, Sort and Summarize button now appear in the toolbar.

Show On-Demand Toolbar on Right-Click Only

The On-Demand Toolbar appears/disappears as you work in your report. In addition to pinning your toolbar you can also set it to only appear when you right-click within your report.

To do this:

1) Check that you are in Edit mode in the report window.
2) Click the More (...) button (next to Properties button) and select Options at the bottom of the menu.
3) When the Options window opens select the View tab.
4) Select Show on demand toolbar on right-click.
5) Click OK to accept your selection.
Turning Interactivity Mode On/Off

As previously mentioned, Interactive reports provide, as the name suggests, interactivity in the report output and will have context sensitive menus that will appear above the object such as filters and grouping.

There are interactive and non-interactive reports. All upgraded reports (those that originated from previous versions of Cognos that have been moved into Cognos Analytics) were brought over with interactivity mode turned off. At the discretion of your package custodian, this feature can, however, be turned back on.

As a report author it is important to understand that when creating NEW reports, Cognos Analytics defaults to having Interactivity Mode turned **ON**. It is usually not the intention of the data stewards to allow end-users (report viewers) to interact with reports.

> *It is a best practice to turn this functionality off when beginning a new report, and before you save this report for the first time.*

To do this:

- When creating a new report, after selecting your template and before selecting your data source, click on the **Report tab** and select **Report**, to open the **Report properties** window.
- In the Properties window go to **Report > Running & Validating**.
- Change **Run with full interactivity** from Yes to **No**.
Creating and Modifying Reports

In this section, we will create a new report, explore the data model, and make modifications.

Creating a New Report in Cognos Analytics

1. From the bottom Left Navigation toolbar, click **New** and select **Report** from the list to create a new **Report**.
2. From the list of templates, choose the **01-Princeton - List Report**. Double-click on the report or select **OK**.
3. Turn **Interactivity Mode** off. Report tab > Report > Properties window > Running & Validating > Yes to **No**.
4. Go back to the **Report** tab and select **Page1**.
5. From the **Insertable objects** window, click the **Add a source** button or the **Select sources** button to select a **Package**.

6. From the list of Reports and Packages navigate to:
   - **Team Content > Training Data – Reports > Training Data Cognos Package > Training Data**.
7. Select the **Training Data** Package. Ignore the **No data** message. Click the **Open** button.
12) Expand the data model to list the query subjects (tables) and query items (fields).

13) In the Source pane navigate to:
   Training Data > Presentation Layer > Fictitious Training Data > Person Bio Data.

14) Open the Person Data table.

15) Drag or double-click to bring a single field into the report.
   Control-click to select multiple query items.

16) Add the following fields into your report:
   - EmplID
   - Last Name
   - First Name

   To add fields to the report, drag the entire selection to the table to the right until you see a blinking, black insertion point as shown below (single lane road with blinking median).

17) Add the following additional items to the report:
   - Home Address Street
   - Home Address City
   - Home Address State
   - Home Address Postal Code
   - School ASC
Validating a Report

Validate your report to ensure it contains no errors. To validate your report:

1. To the right of the Page design menu click on the More (…) button to open the pull-down menu.
2. Select Validate report.

You will see this message if the report is valid. Click OK.

Another way to Validate a report.

2. The Validate button is next to the Copy and Paste buttons.
3. Select Validate report.
   You will see the above message if the report is valid.

Running a Report

Running a report is generating the output using the criteria and report definitions in the report.

1. From the Report tab pull-down menu return to Page1.
2. Click the Run Options button from the application toolbar.
3. Choose Run HTML (or any output format you wish to view your report).
5. When ready to return to the report edit page, close this browser tab.
Saving Report Output

The report output is in the Reporting tab.
You may save report outputs other than HTML.

1. When you run to PDF you may download and save the report output.
2. When you run to Excel or Excel data a window will open allowing you to save your report to your desktop.
3. Close the Reporting tab to return to the New Report tab and page.

Saving a Report

To save the current report, return to the New report tab in your browser.

1. From the application toolbar, click the Save as button.
   The Save as dialog box will open prompting you to choose from the Team Content folder or the My Content folder.
2. Select the My Content folder and navigate to where you want to save your report.
3. You can create a new folder by clicking the New folder (+) button in the top right of the top right of the Save as window.
4. After naming your folder remember to click the Enter key on the keyboard.
5. Do not click the Save button yet!
   Note: You will see a window pop up telling you the new folder has been created.
6. In the Save as: field, name the report Personal Bio Info Report.
7. Click Save. The report is saved with the new file name under your My Content folder.

If you have already saved a report and continued to modify it, clicking directly on the Save button will save your most recent changes. Clicking the drop-down arrow beside the Save button will list other Save options.

Save As Options

Convert to Template: You can create reports that have specific formatting and have icons or text specific to your group/department. If you want to regularly use a specific format you can save the report as a template. When you create a new report the template will be listed among the other templates from which you can select.

Convert to Active Report: Most Princeton reports have interactivity turned off. Active report output provides an interactive and easy to use managed report. Active reports allow users to explore their data and derive additional insight.
Removing a Column
You may need to remove a column. The information may no longer be needed for reporting purposes, or you may need to omit sensitive information from the report.

1. Select the **School ASC** column header or column body (the last column).

   ![Table Example]

2. Press **Delete** on the keyboard to remove the column.

   ![Table Example after deleting School ASC]

3. Click directly on the **Save** button (Orange toolbar, left side) to overwrite the previous save.

**Source Tab vs Data Items Tab**
As you make changes to the report, the items from the **Source** tab (or data model), never change. The **Source** Tab contains all the data available in the **Package**, whether you use it in your report or not. The **Query** represents query items (or fields), used in your report. The **Query** may change as you edit your report, depending on the kind of modifications you make.

*Delete Function*
When we used **Delete** to remove the column, in the exercise above, the data item is deleted from the query, and is no longer found on the **Data Items** tab.

*Cut Function*
To remove a column from the report, and keep the data item in the query, use the “cut” function to cut the column from the report page, so it does no longer displays on the report page.

Using the **Cut** function we’ll learn a little later how to remove a column from the report while keeping it in the query.

1. From the **Insertable objects** window, click the **Data Items Tab** (between the **Sources** and **Toolbox** tab).
2. Examine the query.
3. Notice that each **Query** Item listed is a field that is visible on the report.
4. Notice the **School ASC** field that we deleted is **not visible** on the **Data Items** tab or in the **Report**.
5. Click back onto the **Sources Tab**.
6. Scroll through the **Query Items** listed in the **Person Data** query subject. Notice items that do not appear in the report are still in the data model, **including the column we deleted from the report**.

**Sorting**

You can sort items to view them in a preferred order. By default, Cognos Analytics retrieves items in the order defined in the data source.

In this exercise, we will sort the report data, add a multiple sort, and remove a sort.

1. Select the column heading of the **Last Name** field.
2. From the contextual toolbar that appears, click the **Sort** icon.
3. From the drop-down menu, click **Ascending**.

4. Notice that the **Sort** indicator caret appears in the column header now.

   *When the triangle/caret points up, the column is sorting in ascending order, from A to Z, or from smallest to largest for numeric data.*

   *When the caret is down, the column is sorting in descending order, from Z to A, or from largest to smallest.*
5. Click the Run button. Select Run HTML to run the report.

6. Notice that the Last Name is sorting ascending. Close the New report results window tab.

7. Save the report to accept your Sort order.

*Edit Layout Sorting - Multiple Sorts within a Report*

Multiple columns can be sorted within the same report. Sort order can be different for each column.

In this report the primary sort is an ascending sort on Last Name.

We will change First Name to sort in descending order after the Last Name sort is applied to the data.

1. Highlight the First Name column heading.
2. From the drop-down arrow beside the Sort icon on the contextual toolbar, select Edit Layout Sorting.
3. The Grouping & sorting window opens.

4. Drag the First Name field from the Data Items window into the Groups window.
5. Place First Name under Last Name in the Detailed Sort List folder.
6. With the First Name field selected, change the sort order to Descending by clicking once on the Sort Order toggle button below the Groups window.
7. Click OK.
8. View your report in Page preview mode.
9. Note the sort order for Last Name: Abraham.
   The First Names are now sorting descending.
Removing a Sort – Don’tSort

A sort can be undone.

1. Return to the Page design mode.
2. Click the First Name column heading on the report page.
3. Click the Sort button from the contextual toolbar and select Don’t Sort from the pull-down menu.

Notice that the carat disappears from under the First Name in the column header.

Sort Ascending –First Name

1. Highlight the First Name column header.
2. Open the Sort pull-down menu and select Edit layout sorting.
3. Drag the First Name field from the Data Items window into the Groups window.
4. Place First Name under Last Name in the Detailed Sort List folder.
5. Note that the sort is Ascending
6. Click OK to accept your changes.
7. Click Save to save the changes to your report.
Hiding Columns

We will use the **Cut** function to remove columns from the report page. While the data items no longer display in the report, the data items remain in the query. This allows us to use the item for other purposes such as sorting on the hidden column.

1. Click **Last Name**, then Ctrl+click **First Name** to select both column headings.
2. From the contextual toolbar, click the **Cut** button (scissors).

![Image of report page with columns cut]

The columns (**Last Name** and **First Name**) are now removed (but only hidden) from the report page.

Query Data Items

1. From the **Report** tab, click **Q_List1** under the **Queries** icon.

The query items which make up the query will be listed in the **Data items** pane on the right. Notice the **Last Name** and **First Name** columns are still in the query.
**Note:** Cities in first 3 rows of the report sorted by **Last Name, First Name** are: Reston, New Castle, Lexington.

2. **Run** the report to HTML.

Note that the report is still sorting by **Last Name** although that column is not in the report.

<table>
<thead>
<tr>
<th>EmplID</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>304C5965</td>
<td>40 8th Road</td>
<td>Reston</td>
<td>VA</td>
<td>22101</td>
</tr>
<tr>
<td>300787A1</td>
<td>60 Almo Circle</td>
<td>New Castle</td>
<td>PA</td>
<td>19041</td>
</tr>
<tr>
<td>308A550X</td>
<td>70 Alpine Park</td>
<td>Lexington</td>
<td>KY</td>
<td>42071</td>
</tr>
<tr>
<td>13C573CV</td>
<td>100 2nd Pass</td>
<td>North Las Vegas</td>
<td>NV</td>
<td>89148</td>
</tr>
<tr>
<td>3408A49Y</td>
<td>70 Bonner Junction</td>
<td>New York City</td>
<td>NY</td>
<td>11234</td>
</tr>
<tr>
<td>3A80633B</td>
<td>30 Cottonwood Trail</td>
<td>Rockville</td>
<td>MD</td>
<td>20747</td>
</tr>
<tr>
<td>301A5944</td>
<td>8 Knutson Court</td>
<td>Brooklyn</td>
<td>NY</td>
<td>10573</td>
</tr>
<tr>
<td>301A9944</td>
<td>90 Brown Way</td>
<td>Denver</td>
<td>CO</td>
<td>80126</td>
</tr>
<tr>
<td>331E85EQ</td>
<td>60 Blue Bill Park Drive</td>
<td>Atlanta</td>
<td>GA</td>
<td>30328</td>
</tr>
<tr>
<td>30989880</td>
<td>40 Cardinal Junction</td>
<td>Belfast</td>
<td>Northern Ireland</td>
<td>SN101DE</td>
</tr>
<tr>
<td>303708C1</td>
<td>10 Buena Vista Crossing</td>
<td>San Jose</td>
<td>CA</td>
<td>95826</td>
</tr>
<tr>
<td>305708C1</td>
<td>339 8th Junction</td>
<td>Trenton</td>
<td>NJ</td>
<td>08070</td>
</tr>
<tr>
<td>3090001E</td>
<td>0380 Pleasure Way</td>
<td>Boston</td>
<td>Massachusetts</td>
<td>02166</td>
</tr>
<tr>
<td>3090001E</td>
<td>90 Comanche Parkway</td>
<td>Los Angeles</td>
<td>CA</td>
<td>91754</td>
</tr>
<tr>
<td>3707A48L</td>
<td>2 Bunker Hill Hill</td>
<td>Jersey City</td>
<td>NJ</td>
<td>07017</td>
</tr>
<tr>
<td>31B567F</td>
<td>70 Lakewood Place</td>
<td>Kalamazoo</td>
<td>MI</td>
<td>49001</td>
</tr>
<tr>
<td>3107A93U</td>
<td>80 Dexter Point</td>
<td>Ipo</td>
<td>Perak</td>
<td>47300</td>
</tr>
<tr>
<td>13C57SCZ</td>
<td>600 Farm Drive</td>
<td>Odessa</td>
<td>TX</td>
<td>78201</td>
</tr>
<tr>
<td>310790DM</td>
<td>80 Escher Drive</td>
<td>Whistler</td>
<td>BC</td>
<td>V8V4H5</td>
</tr>
<tr>
<td>31A5971F</td>
<td>20 Forest Junction</td>
<td>Hayattsville</td>
<td>MD</td>
<td>20817</td>
</tr>
</tbody>
</table>

3. **Close** the Reporting tab. You should return to the report page.

**Deleting** a column (via keyboard or icon) removes the column from the report page and the data item from the query.

**Using the Cut icon** removes the column from the report, but leaves the data item in the query. **Use Cut** when you need to leave a data item in the query, but do not want to see it on the report page.

**Moving Columns**

After running a report it is easy for the user to change the order of the columns in the report. In this exercise, we will practice rearranging columns.

1. Return to the report page.
2. If you are not there, under the **Report** tab click on the **Page1** button.
3. Click the **EmplID** column body or header to select it.
4. Drag the selected **EmplID column** to the end of the report, after **Home Address Postal Code**.
   
   Release when you see the blinking one lane highway. You can also select the column body, Ctrl-C to cut it.
   
   Click on the right edge of the list to select all of it, the Ctrl-V to paste the EmplID column.

5. View in [Page preview](#).
6. Return to [Page design view](#).
7. Save the report.

**Adding a Column**

There are several ways to add columns to a report from the [Sources tab](#).

- Double-click on the item you want to add.
- Right-click on the data item and choose **Insert**.
- Click and drag the item to the report

1. From the [Insertable objects](#) window click the [Sources](#) icon.
2. Select the field to the right of where you would like the field to appear.
3. Select the **Home Street Address** column header or body.
4. Right-click the **Gender** field and click **Insert**.
   
   The new data item will be inserted to the left of the column that you’ve highlighted.

The **Gender** field will be inserted as the first column in the report.

*The new column will be placed before the selected column.*

*If no column is selected, the new column will be placed at the end of the report.*
5. Run to HTML.

We can see that the Gender agrees with the First Name of the first 4 rows.

6. Close the Reporting tab.

7. Save the report.

Singletons

You can insert a single data item anywhere in your report using the Singleton object from the Toolbox tab. The singleton object retrieves only the first row value for that query.

Inserting a single data item is useful when you want to show a value that is independent from the rest of the values in the report.

Singletons can be inserted accidentally when dragging data items into our reports. To delete select the Singleton and Delete or select the Undo button to remove the last action. The Undo and Redo buttons are located in the top left orange toolbar next to the Edit button.
1. Navigate to Team Content > Training Data - Reports > Cognos Analytics Class Reports > Exercise 1: Personal Data Report.
2. Click on the Edit button, in the orange toolbar if you are not in Edit mode.
   Tip: If you click once in the report window the contextual toolbar should appear, which it does in Edit mode.
3. Check that you are in Page design view.
   Hint: go to the Page views icon in the orange toolbar.
4. Save the report as “Exercise 1: Personal Data Report” in your My Content area.
5. Check that Interactivity Mode is turned off.
6. Delete the Middle Name column. Hint: Select the column header or column body. Use the Delete button on your keyboard, or select the Delete (trashcan) button from the contextual toolbar.
7. Add the Birth Date field as the second column of the report.
   Hint: select the column header or column body immediately to the right of where you want to insert Birth Date. Right click on Birth Date and select Insert.
8. Add the Last Name and First Name back into the report from the Data items tab, as columns 2 and 3.
   Hint: The Data items tab is between the Sources and Toolbox tab to the left of the report page.
   Note: In the Data items tab you must drag and drop a new data item(s) into your report.
   You cannot select a report column and right-click on the data item you want to add to the report.
   This action is only enabled in the Sources pane.
9. Remove the Sort on Last Name. Sort Ascending on Birthdate.
   Hint: Select the column header or body. From the contextual toolbar Sort pull-down menu, select your action.
10. Change to Page Preview mode to confirm that you are viewing the youngest students to oldest moving down the report.
    Hint: Use Page Down or Bottom button at the bottom of the page.
11. Hide the Birthdate column.
    Hint: Select Cut from the contextual toolbar. Do not delete.
12. Run your report. Save your report.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>3J10619</td>
<td>Illnow</td>
<td>3733 Mariners Cove Street</td>
<td>Boston</td>
<td>MA</td>
<td>02468</td>
<td></td>
</tr>
<tr>
<td>3J10619</td>
<td>Illnow</td>
<td>8973 High Crossing Parkway</td>
<td>Laurel</td>
<td>MD</td>
<td>20874</td>
<td></td>
</tr>
<tr>
<td>484N7721</td>
<td>McClure</td>
<td>53816 Darwin Trail</td>
<td>Fresno</td>
<td>CA</td>
<td>92706</td>
<td></td>
</tr>
<tr>
<td>70805W66</td>
<td>Underwood</td>
<td>1390 Barfalt Junction</td>
<td>Wilkins Barre</td>
<td>PA</td>
<td>19085</td>
<td></td>
</tr>
<tr>
<td>70805W66</td>
<td>Underwood</td>
<td>96077</td>
<td>Seattle</td>
<td>WA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>65605U77</td>
<td>Stone</td>
<td>557 Ridge Oak Drive</td>
<td>Dallas</td>
<td>TX</td>
<td>76320</td>
<td></td>
</tr>
<tr>
<td>65509U77</td>
<td>Stone</td>
<td>8344 Buell Junction</td>
<td>Dallas</td>
<td>TX</td>
<td>76320</td>
<td></td>
</tr>
<tr>
<td>4K03250K</td>
<td>Jain</td>
<td>3622 Holy Cross Place</td>
<td>New York City</td>
<td>NY</td>
<td>12180</td>
<td></td>
</tr>
<tr>
<td>9K03264</td>
<td>Warren</td>
<td>5108 Elka Pass</td>
<td>Jersey City</td>
<td>NJ</td>
<td>06806</td>
<td></td>
</tr>
<tr>
<td>9K03264</td>
<td>Warren</td>
<td>930 Declaration Point</td>
<td>Trenton</td>
<td>NJ</td>
<td>06822</td>
<td></td>
</tr>
<tr>
<td>6K037T4</td>
<td>Sara</td>
<td>79 John Well Place</td>
<td>Trenton</td>
<td>NJ</td>
<td>06704</td>
<td></td>
</tr>
<tr>
<td>4K023L03</td>
<td>Liu</td>
<td>4920 Atwood Court</td>
<td>Columbus</td>
<td>OH</td>
<td>45215</td>
<td></td>
</tr>
<tr>
<td>4N047N01</td>
<td>Milne</td>
<td>57466 Judy Terrace</td>
<td>R S</td>
<td>Gujarat</td>
<td>700019</td>
<td></td>
</tr>
<tr>
<td>3K078A1</td>
<td>Abbass</td>
<td>60 Almo Circle</td>
<td>New Castle</td>
<td>FA</td>
<td>19041</td>
<td></td>
</tr>
<tr>
<td>34069T70</td>
<td>Comish</td>
<td>173 Pottery Trail</td>
<td>Brockton</td>
<td>MA</td>
<td>02470</td>
<td></td>
</tr>
<tr>
<td>34069T70</td>
<td>Comish</td>
<td>23 Myrtle Street</td>
<td>Agarharam</td>
<td>Andhra Pradesh</td>
<td>721306</td>
<td></td>
</tr>
<tr>
<td>530120R</td>
<td>Piper</td>
<td>033 Mallory Court</td>
<td>Pelingwang</td>
<td></td>
<td>312000</td>
<td></td>
</tr>
<tr>
<td>530120R</td>
<td>Piper</td>
<td>7 Brentwood Plaza</td>
<td>Torrance</td>
<td>CA</td>
<td>94006</td>
<td></td>
</tr>
<tr>
<td>5R6R5654</td>
<td>Riquas</td>
<td>7474 Ione Court</td>
<td>New Orleans</td>
<td>LA</td>
<td>70448</td>
<td></td>
</tr>
<tr>
<td>5R6R5654</td>
<td>Riquas</td>
<td>96482 Redwing Park</td>
<td>Spokane</td>
<td>WA</td>
<td>90337</td>
<td></td>
</tr>
</tbody>
</table>
Grouping and Aggregation

Grouping a List Report

If a column in a report contains multiple instances of the same value, you can group these identical values together. Grouping reorders the rows of a selected report item so that identical values appear together and duplicates are suppressed in the display.

Grouping (and/or ungrouping) might change the order of the report items as grouped columns precede ungrouped columns. However, you can reorder the list columns to make the report more readable.

Grouping columns of data makes it easier to find data, as all like items are within the same grouping. After grouping data, the columns can have a count, total, average, or similar function applied to them.

In this exercise, we’ll group columns to organize all of the records returned by Home Address Country.

1. Open the Personal Bio Info Report for editing. Check that you are in Edit (pencil underlined) mode.
2. Save the report as Personal Data Report – Grouped in your My Content area.
3. Delete the Gender column.
4. Add the Home Address Country field to the report.
5. Move the Home Address Country field to the first column.
6. Save the report. Run the report HTML. Page down to view the Home Address Country data.
7. Notice that there are many rows with Home Address Country = USA, and other countries listed sparingly.
8. **Close** the **Reporting** tab.
9. **Click** once on the **Home Address Country** column header.
10. From the contextual toolbar, click the **Group/Ungroup** button.

![Image of a spreadsheet with a group icon]

The **Group** icon appears in the list column body.

![Image of the same spreadsheet with the group icon highlighted]

11. **Run** the report to HTML. Notice that the **Home Address Country** is now grouped alphabetically ascending.
12. At the bottom of the window, click the **Bottom** button to go to the end of the report.
13. The USA data is grouped by **Home Address Country**. Notice that **Home Address State** is not sorted.

<table>
<thead>
<tr>
<th>Home Address Country</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>EmpID</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>99396 Mosinee Avenue</td>
<td>San Francisco</td>
<td>CA</td>
<td>91791</td>
<td>4702740N</td>
</tr>
<tr>
<td>9964 Dexter Way</td>
<td>Stamford</td>
<td>CT</td>
<td>06811</td>
<td>Z4702750</td>
<td></td>
</tr>
<tr>
<td>9969 Carioca Hill</td>
<td>El Paso</td>
<td>TX</td>
<td>77024</td>
<td>902754P</td>
<td></td>
</tr>
<tr>
<td>9968 Thierer Lane</td>
<td>Chicago</td>
<td>IL</td>
<td>60293</td>
<td>902762T</td>
<td></td>
</tr>
<tr>
<td>9965 Northridge Way</td>
<td>Philadelphia</td>
<td>PA</td>
<td>18405</td>
<td>902763U</td>
<td></td>
</tr>
<tr>
<td>99939 Boyd Parkway</td>
<td>Denver</td>
<td>CO</td>
<td>80129</td>
<td>902772C</td>
<td></td>
</tr>
<tr>
<td>9967 Florence Point</td>
<td>Duluth</td>
<td>GA</td>
<td>30005</td>
<td>ZZ90277B</td>
<td></td>
</tr>
<tr>
<td>Atlanta</td>
<td>Georgia</td>
<td>GA</td>
<td>30629</td>
<td>902776F</td>
<td></td>
</tr>
<tr>
<td>Cinnaminson</td>
<td>Fort Dix</td>
<td>AE</td>
<td>09839</td>
<td>Z090278B</td>
<td></td>
</tr>
<tr>
<td>Cole</td>
<td>47915 Oak Valley Center</td>
<td>DC</td>
<td>20016</td>
<td>902782L</td>
<td></td>
</tr>
<tr>
<td>Daniels</td>
<td>8 Thierer Avenue</td>
<td>DC</td>
<td>20016</td>
<td>4302784D</td>
<td></td>
</tr>
<tr>
<td>Fisher</td>
<td>41014 Waubesa Parkway</td>
<td>DC</td>
<td>20008</td>
<td>4302787E</td>
<td></td>
</tr>
</tbody>
</table>

14. **Close** the Reporting tab.

15. **Save** your report.

16. Click the column heading of **Home Address State**.

17. Click the **Group/Ungroup** icon. Notice that the **Group** icon now appears in the column body.
18. Run the report.
19. The report is now grouping by **Country** and **State**.
   If there are no states in a country then the field is blank.

![Personal Data Report - Grouped](image)

20. Scroll down through the report or use the **End** button on your keyboard to see the USA states.
    Notice that the USA states are grouped alphabetically ascending.

![Personal Data Report - Grouped](image)

21. Close the **Reporting** tab.
22. Save the report.
23. Click the **Home** button.
Level Spanning

Level Spanning controls how often the user chooses to show a particular item within a group. It is helpful to group all like records together and have each record’s information appear on each line.

Let’s create a new report for this exercise.

1. Click the New button to start a new Report.
2. Choose the 01 - Princeton List Report template.
5. Select a source and navigate to the Training Data Package:
   - Team Content > Training Data Reports > Training Data Cognos Package > Training Data
   (Ignore the No data matched message.) Click the Open button.
6. Navigate to Student Date > Student Class Data query subject and open it.
7. Add the below data items to your list report:
   - EmpIID
   - Academic Career
   - Academic Program
   - Academic Dept
8. Save the report as Level Spanning in your My Content area.
9. Run the report to PDF.
10. Notice that there is lots of duplication in the Academic Career, Academic Program and Academic Dept. fields.
11. Close the Reporting tab.
12. **Group** the last three columns together.
   **Hint:** Control+click to select all 3 column headers. The **Group** icon is in the contextual toolbar above the columns.
13. Notice that the **Group** icon now appears in all 3 column lists.
14. **Save** the report.

15. **Run** the report.

   If you scroll down a few pages, notice that when the **Academic Dept** changes, the **Academic Program** does not show next to the new **Academic Dept**.

   The records are grouped by **Academic Career**, then by **Academic Program**, and next by **Academic Department**.

16. **Close** the **Reporting** tab.

   For the **Academic Program** to be listed next to each **Academic Department** listing the **Level Span** association must be made.
17. Highlight the Academic Program column body and go to the Properties window Data section.

18. Under the Data section, click Group Span to open the drop-down menu.
19. Click the drop-down arrow.
20. Select Academic Dept from the list.

21. Run the report.
22. Page down and notice that each time the Academic Dept changes, the Academic Program now shows next to the new Academic Dept.
23. Close the Reporting tab.
24. Save the report.
Sections
Sections are similar to groupings. A section differs in that it shows the query item as the heading of a section or area within the report.

In this exercise, we will create a Section based on Academic Career.

1. **Save** this report in My Content as Sections.

   We will need to undo the Level Spanning property done in the previous exercise.

2. Highlight the Academic Program Column Body and locate Group Span under Data in the Properties pane.

3. Click the drop-down arrow to reveal a list of query items (other grouped fields) and choose Academic Career. Notice that the Academic Program Column Body formatting changes.

4. Highlight the Academic Career column heading.

5. From the contextual toolbar, next to the Group/Ungroup icon, open the Section/Unsection drop-down menu and select Section/unsection.

Notice the Academic Career field now appears above the column headers.
6. In the Properties window go to Data, Rows per page.
7. Next to Rows Per Page, enter 100. This will allow us to see more rows in the window when we run the report to HTML.
8. Run the report to HTML.
9. Identify the Academic Career section breaks.
10. Use the Page down button at the bottom of the report page to move through the report until you see the Academic Career change from GR to UG.
11. Close the Reporting tab.
12. Save the report.
Page Breaks

Report pages can be separated by designated grouped fields. For Cognos Analytics to insert a page break for fields, a field must be grouped or sectioned.

1. Save the report as Page Breaks.
2. From the Report tab, click on the Pages tab.
3. From the Insertable objects window, select Page set and drag it to the Pages section above Page1.

4. Drag Page1 into the Detail Pages folder. Page1 should appear below and to the right of the Detail Pages folder.

5. Click to select Page Set1.
6. Go to the Page set Properties window Data section.
7. Open the Query menu.
8. Select Q_List1.
9. From the Page set Data section in the Properties pane, click the Grouping and sorting property.
10. Click the More button to open the Grouping & sorting dialog box to help us group by Academic Career.
11. From the **Data Items** section, drag **Academic Career** to **Overall** in the **Groups** section.
   The **Groups** sort order should look like the screen shot.
12. Click **OK**.

13. **Run** the report to PDF.
14. **Scroll down to page 15.**
   You will notice that **Academic Career: GR** ends on this page, and **Academic Career: UG** begins on Page 16.
   At the end of each **Academic Career**, you will now go to the next page to view the next **Academic Career** group.
15. **Close** the **Reporting** tab.
16. **Save** the report.
Try it!

Create a new list report from the Person Data Query Subject that uses the below data items:

- EmpID
- Last Name
- First Name
- Home Address Street
- Home Address City
- Home Address State
- Home Address Postal Code
- Home Address Country

Then:

2. Group the report by Home Address Country.
3. Sort by Last Name in Ascending order.
4. Run the report. Confirm that the Home Address Country is sorting in ascending order.
5. Close the Reporting tab.
6. Save the report in your My Content area as “Grouping Exercise”.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Home Address Street</th>
<th>Home Address City</th>
<th>Home Address State</th>
<th>Home Address Postal Code</th>
<th>Home Address Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>39L4653J</td>
<td>Honore</td>
<td>Viraj</td>
<td>355 Quayside</td>
<td>Curacao</td>
<td></td>
<td>00000</td>
<td>ANT</td>
</tr>
<tr>
<td>313H11D</td>
<td>Cochran</td>
<td>Amanda</td>
<td>15485 Wayridge Court</td>
<td>Umm al Qaywayn</td>
<td></td>
<td></td>
<td>ARE</td>
</tr>
<tr>
<td>65304U1B</td>
<td>Scott</td>
<td>Luke</td>
<td>8 Great Line Lane</td>
<td>Dubai</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7X9X300H</td>
<td>Vettis</td>
<td>Akayla</td>
<td>90 Columbus Center</td>
<td>Al Fujairah</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13C57706</td>
<td>Ambellotis</td>
<td>Roseanne</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td>AUS</td>
</tr>
<tr>
<td>475K47A</td>
<td>Lind</td>
<td>Dillum</td>
<td>48 Barnett Street</td>
<td>Ridgeley</td>
<td></td>
<td>4216</td>
<td></td>
</tr>
<tr>
<td>51018R2Q</td>
<td>Panzello</td>
<td>Mohammed</td>
<td>65 Ross Smith Avenue</td>
<td>Darwin</td>
<td>NTE</td>
<td>6015</td>
<td></td>
</tr>
<tr>
<td>5101S1M</td>
<td>Patania</td>
<td>Paschalia</td>
<td>37 Springhill Bottom Road</td>
<td>Perth</td>
<td>TSM</td>
<td>2065</td>
<td></td>
</tr>
<tr>
<td>6X85560X9</td>
<td>Tamrakar</td>
<td>Kariss</td>
<td>87 Quayside Vista</td>
<td>Canberra</td>
<td>ACT</td>
<td>2071</td>
<td></td>
</tr>
<tr>
<td>51093R3B</td>
<td>Nahata</td>
<td>Yannai</td>
<td>6 Sauthoff Drive</td>
<td>Niederwaldkirchen</td>
<td>Oberösterreich</td>
<td>2560</td>
<td>AUT</td>
</tr>
<tr>
<td>K0902422</td>
<td>Wei</td>
<td>Jonann</td>
<td>93916 Springs Parkway</td>
<td>Villach</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>430271U</td>
<td>Younger</td>
<td>Charu</td>
<td>99 6th Junction</td>
<td>Niederwaldkirchen</td>
<td>Oberösterreich</td>
<td>1030</td>
<td></td>
</tr>
<tr>
<td>388335HF</td>
<td>Franklin</td>
<td>Rona</td>
<td>25268 Lindbergh</td>
<td>Tunghyyra</td>
<td></td>
<td>1212</td>
<td>BGD</td>
</tr>
<tr>
<td>345G6666</td>
<td>Cooper</td>
<td>Nitish</td>
<td>170 Sauthoff Center</td>
<td>Rila</td>
<td></td>
<td>1510</td>
<td>EGR</td>
</tr>
<tr>
<td>41029MMV</td>
<td>Khan</td>
<td>Abuzar</td>
<td>42 Eagle Great Street</td>
<td>Blagoevgrad</td>
<td></td>
<td>8000</td>
<td></td>
</tr>
<tr>
<td>A78692C5</td>
<td>Arubucke</td>
<td>Diana</td>
<td>010 Warbler Lane</td>
<td>Blagaj</td>
<td></td>
<td>74000</td>
<td>BIH</td>
</tr>
<tr>
<td>31EE7E14</td>
<td>Avery</td>
<td>Amanda</td>
<td>010 Warbler Lane</td>
<td>Blagaj</td>
<td></td>
<td>74000</td>
<td></td>
</tr>
<tr>
<td>0920533F</td>
<td>Wilton</td>
<td>Annija</td>
<td>95678 Larry Crossing</td>
<td>Glimoje</td>
<td></td>
<td>88000</td>
<td></td>
</tr>
<tr>
<td>3107D6F</td>
<td>Atchison</td>
<td>Molly</td>
<td>025 Milwaukee Lane</td>
<td>Ponta Porã</td>
<td></td>
<td>12243830</td>
<td>BRA</td>
</tr>
<tr>
<td>3828810F</td>
<td>Eliasen</td>
<td>Seeyuen</td>
<td>2224 Bashford Hill</td>
<td>São Lourenço</td>
<td></td>
<td>78200000</td>
<td></td>
</tr>
</tbody>
</table>
Calculations

Simple, complex and macro calculations can be created in Cognos Analytics. We’ll create reports with basic calculations.

We can create a calculated column by multiplying one column with another. Grouping a column allows you to keep all similar data together, and to add summaries for each group. Some summaries include counts, averages, and totals. For example, you can count the number of rows, show the average numbers in a group, and show group totals.

We will create a basic report we will save and use to create different types of calculated reports.

1. Click the New button to create a new report.
2. Choose the Princeton List Template.
3. Turn Interactivity Mode off.
5. Under Insertable objects select the Sources tab.
6. Navigate to: Team Content > Training Data Reports > Training Data Cognos Package.
7. Select and open the Training Data Package.
8. From the Person Bio Data > Person Data query subject, pull over the following query items:
   - Last Name, Middle Name, First Name, Birth Date
9. Control-click to select several items at a time. The order in which you select the items is the order in which they will populate the columns from left to right. Drag and drop when you see the blinking single lane road.
10. Save the report in your My Content area as Calcs.
11. Page preview mode. Note that there is no sort order to the report. Let’s sort by Last Name, First Name and Middle Name ascending.
12. Return to Page design mode when ready.
13. Sort the report by Last Name, First Name, and Middle Name ascending.
   Hint: Select the Last Name column body and select the Sort button from the contextual toolbar.
   Then select the First Name column body and select Edit layout sorting from the Sort button pull-down menu.
   Drag the First Name under the Last Name in the Groups window. Then drag the Middle Name under the First Name: Note that the blue carats are point up for ascending order.
15. Save your report.
Adding a Calculated Column

A calculated column is a new data column created by the user, that does not exist in the data model. We will create a calculated column for Age using the existing Birthdate field. We will calculate a person’s age using the Birth Date field and an SQL function in a new field named “Age”.

1. Save the report as Age Report.
2. From the Insertable objects section, click the Toolbox tab.
3. Open the Textual section.
4. Select Query Calculation and drag it to the right of the Birth Date column. Release when you see the blinking one lane highway.

5. The Data item expression window opens.
6. In the Name field type Age. This will appear as your column header.
7. Select the Functions tab and open the Business Date/Time Functions folder.
8. Scroll down to find _years_between_.
9. Double-click on _years_between_ or drag it into the Expressions Definition window on the right.
10. Open the Common Functions folder and then open the folder A-C.
11. Double-click the current_date function to add it to the Expressions Definition window on the right.
12. Type a comma and a space after current_date to separate functions.
13. Click the Data Items Tab and locate Birth Date.
14. Double-click Birth Date to add it to the Expression Definition area on the right.
15. Type a closed parenthesis after Birth Date.
16. Click the Validate button to ensure there are no errors with your calculation.
17. Click OK.

Note: If you take Birth Date from the Source data you will see the qualified name of the data item in the expression, i.e. years_between(current_date, [Fictitious Training Data].[Person Data].[Birth Date].

If you take Birth Date from the Data items in the report you will just see the Data item in the expression.

Expression Definition: years_between (current_date, [Birth Date])
18. Run the report.
   The Age column shows the calculated age values.
19. Close the Reporting tab.
20. Save your report.

Understanding Aggregation

Aggregation is the summarization of grouped items. Cognos Analytics automatically groups non-numeric data (text or date) and summarizes numeric data. The numbers you see in your reports are probably a summarization of the raw data from the database.

The user can turn this default automatic aggregation off at the report level.

   1. Select the Q_List1 query from the Report pull-down menu.
   2. The Properties pane is on the far right.
   3. Under Data go to Auto group and summarize.
   4. The default value is Yes. Set the value to No.
   5. Save your report.

Types of Aggregation:

Some of the common types of aggregation are:

- **Total**: Sums the items in the group
- **Average**: Averages the items in the group
- **Minimum**: Shows the smallest number in the group
- **Maximum**: Shows the largest number in the group
- **Count**: Counts the number of items in the group

The default type of aggregation for each numeric data item is set in the package.

Totaling a Column - Adding Summary Totals

You can also create additional aggregates within the report.
You can group the report and add summaries to the group footers.

An ungrouped report will show counts, totals, etc. for the entire report.
If the report is grouped, and then counts, totals, etc., are added, the report will show the summaries for each individual group and for the report as a whole.

This exercise will total the EmplIDs by Academic Track and also give a summary total of all EmplIDs.

1. Create a new list report using Student Class Data in the Student Data query subject with the below fields:
   Team Content > Training Data > Reports > Training Data Cognos Package > Training Data
   - Academic Program Descr
   - Academic Track
   - EmplID

2. Save the Report in My Content as Calculated ID List.
3. Highlight the EmplID List Column Body.
4. In the **Properties** pane, scroll way down to the **Data Item** section and set the **Detail Aggregation** to **Count**. Scroll up to see **Count**.

5. **Sort** the **Academic Program Descr** ascending. Use the **Sort** feature in the contextual toolbar.

6. View the report in **Page preview** mode.

The **EmplIDs** are counting the number of students in each **Academic Track**.

7. Select the **EmplID List Column Header**.

8. In the contextual toolbar, click the drop-down arrow to the right of the **Summarize** icon and choose **Calculated** from the pull-down menu. The design view changes to show that the **Summary Calculated row** totaling all **EmplIDs** is now at the end of our report.

9. **Save** your report.

**Note**: Numbers are not formatted to show thousands separators.
**Formatting Numbers – Align & Justify**

We can format numbers in the **Data format** window.

1. Return to **Page design** mode.
2. Highlight the **EmplID** column body and control-click to also highlight the **Calculated(EmplID)** field.
3. Select the **Data format** icon.
4. When the **Data format** window opens select **Number** under **Format type**.
5. In the **Properties** window next to the **Use thousands separator** select **Yes**.
6. Select **OK** when ready.
7. View in **Page preview mode**. The thousands separators now appear. Note that the numbers are not right justified in the column.
8. In the **Properties** window under **Font & Text** open the **Horizontal alignment** pull-down menu and select **Right** to justify the numbers.
9. **Save** the report.
Remove the Summary Footer

Save the report as **Calculated ID List – Grouped Summary**

In preparation of **Grouping** and counting by column we need to remove the **Summary** footer:

1. Select the **Overall - Calculated** footer at the bottom of the report.
2. Use the **Delete** key on your keyboard to remove the summary footer and the EmplID from the report.
3. **Save** the report.

**Grouped Summary Footers**

We will group summarize by **Academic Track** and **Academic Program** adding a **Summary** count for all EmplIDs.

1. Use the **Calculated ID List – Grouped Summary** report. View in **Page design** mode.
2. **Group** the **Academic Program Description** and then the **Academic Track** fields.
   - Select one column field at a time and click once on the **Group/Ungroup** button.
3. **Highlight** the **EmplID List Column Body**.

4. In the **Properties** pane, **Data Item** section, set the **Detail Aggregation** to **Count** (if it is not already set).
5. **Highlight** the **EmplID** Column Header.
6. From the contextual menu, click the drop-down menu to the right of the **Summarize** icon and choose **Calculated**.

The **Overall Calculated** footer appears at the end of the report.
7. View in **Page preview** mode.

<table>
<thead>
<tr>
<th>Academic Program Descr</th>
<th>Academic Track</th>
<th>EmplID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bachelor of Arts</td>
<td>Architecture</td>
<td>7,713</td>
</tr>
<tr>
<td></td>
<td>Education</td>
<td>7,074</td>
</tr>
<tr>
<td></td>
<td>Language and Human Development</td>
<td>15,373</td>
</tr>
<tr>
<td>Bachelor of Arts - Calculated</td>
<td></td>
<td>30160</td>
</tr>
<tr>
<td>Bachelor of Science</td>
<td>Agriculture and Life Sciences</td>
<td>10,984</td>
</tr>
<tr>
<td></td>
<td>Engineering</td>
<td>5,480</td>
</tr>
<tr>
<td></td>
<td>Government and Politics</td>
<td>8,272</td>
</tr>
<tr>
<td>Bachelor of Science - Calculated</td>
<td></td>
<td>24736</td>
</tr>
<tr>
<td>Masters of Medical Sciences</td>
<td>Graduate School of Medical Sciences</td>
<td>6,552</td>
</tr>
<tr>
<td>Masters of Medical Sciences - Calculated</td>
<td></td>
<td>6552</td>
</tr>
<tr>
<td>Veterinary Science</td>
<td>Agriculture and Life Sciences</td>
<td>2,624</td>
</tr>
<tr>
<td></td>
<td>Veterinary Medicine</td>
<td>712</td>
</tr>
<tr>
<td>Veterinary Science - Calculated</td>
<td></td>
<td>3336</td>
</tr>
<tr>
<td>Overall - Calculated</td>
<td></td>
<td>64784</td>
</tr>
</tbody>
</table>

**Format the EmplID column**

1. The **Summary** and **Overall – Calculated** fields need to be formatted with thousands separators.
2. Select the **Summary** fields and **Ctrl click** to select the **Overall – Calculated** field.
3. In the **Properties** window select **Data format** to open the window.
   **Note:** You may access the **Data format** window from both the **Properties** pane and the contextual toolbar **Data format** icon.

4. Under **Format type** select **Number**.

5. Under **Properties > Use thousands separator** select **Yes**.

6. Select **OK** when ready.

7. Save the report.
Renaming Headers

Let’s rename the **Academic Program Descr** label to display only **Academic Program**.

1. Highlight the **Academic Program Descr** column header.

   ![Table with Academic Program Descr column](image1.png)

2. Go to **Properties > Data Item** and add **Academic Program** to **Label**. You may need to scroll down.

   ![Data Item with Academic Program label](image2.png)

3. **Academic Program** is now displaying as the column header.
4. **Save** the report.

![Table with Academic Program column](image3.png)
Auto Group and Summary
The automatic group and summary feature is unchecked in Cognos v11.1.7. You can activate this feature if you want it turned on for all list reports. Go to edit mode in a report. **Do not make the actual change to settings at this time.**

- Open the More pull-down menu next to the Page view buttons in the upper right toolbar.
- Select Options at the bottom of the pull-down menu.
- Click the Report tab in the Options window.

- **Check** the box next to Automatic group and summary behavior for lists.
- Click OK if you want to accept this change.

**Do not make the actual change to settings at this time.**
Summary Calculation - Count by EmplID

You may want to show aggregate data without showing the detail. We will create a column that shows only the count of EmplIDs by Academic Track, not including a Summary footer.

1. Open the original Calculated ID List report.
   Go back to the Home Page Recent area to open the report in edit mode. There will be a black line under the Edit button when in Edit mode.
2. Save the report as Acad Program Summary Count by Acad Track.
3. Select the Overall-Calculated field and select Delete from your keyboard.
4. Save the report.

5. Group the Academic Program Descr and the Academic Track columns.
6. Change to Page preview mode.
7. Highlight the EmplID list column body.

8. Go to the Properties > Data item section.
   Scroll down to see the Data item section.
9. Change Detail aggregation to None.
10. View in Page preview mode.
    Notice that the individual EmplIDs show within each Academic Program and Academic Track.
11. Save your report.
**Detail Aggregation - Count**

We want to **Count** each **EmplID** versus, view each **EmplID** value. To do that we need to count each data item.

1. Click the **EmplID** list body column.
2. In the **Properties** pane, scroll to the **Data Item** section.
3. Click the drop-down arrow next to **Detail aggregation** and select **Count**.
   Notice that the **EmplIDs** have vanished and there is a total for each **Academic Track**.

4. Select the **EmplID Column Heading**.
5. In the **Properties** pane, scroll up to the **Text Source** section.
6. From the **Source Type** field, click the drop-down arrow and select **Text**.
7. The table will update and the **EmplID** field will prompt you to **double-click to edit text** in the header.
8. The **Text** window opens.
9. Type **“Student Count”**. Click **OK**.
   The label is changed. **Save** your report.
10. View in **Page preview** mode.
Stretch Your Thinking

COUNT VS COUNT DISTINCT

What’s the difference between these two functions?

Answer:

Using the following criteria: EMPLID, HOME ADDRESS STATE, HOME ADDRESS COUNTRY

- Based on the report criteria, the Count function returns the number of values in the column you specify to be counted.

Example: If you were doing a Count on EmplIDs (some having multiple addresses), Cognos would return a total number of EmplIDs for the entire database, counting some EmplIDs more than once.

- The Count Distinct function returns the number of unique values in the column you specify to be counted.

Example: If you wanted Cognos to return the number of unique EmplIDs (multiple addresses may be associated with some EmplIDs), you would use the Count Distinct function on EmplID.
Try It

Try it!

1. Create a **new/blank** report.
2. Turn **Interactivity Mode** off.
3. Open the Training Package and expand the **Person Data** Query Subject.
4. Drag **EmplID**, **Home Address State**, and **Home Address Country** into the report.
5. Sort **EmplID** in **Ascending** order.
6. Perform a **Count** function on **EmplID**.
   Hint: use the **Summary** pull-down in the contextual toolbar.
7. **Run** the Report.
8. To view the **Overall-Count**, click the **Bottom** link to get to the end of the report.

Notice the overall count for EmplIDs is **2166**.

1. **Save** the report as “**Stretch Your Thinking – Count on EmplID**”
2. Select the **<Count (EmplID)>** row and press **Delete** or **Cut**.
3. **Save** as **Stretch Your Thinking – Count Distinct on EmplID**.
4. Now, perform a **Count Distinct** function on **EmplID**.
   Hint: use the **Summary** pull-down in the contextual toolbar.
5. **Run** the report.
6. To view the **Overall - Count distinct**, click the **Bottom** link to get to the end of the report.

Notice the **Overall - Count distinct** for EmplIDs is now **1775**.

1. Close the Reporting tab.
2. **Save** the Report.

End of Part 1
This training guide continues with Part 2 which can be found at [https://cedar.princeton.edu/education-outreach/elearning-and-documentation](https://cedar.princeton.edu/education-outreach/elearning-and-documentation).

Additional documentation is being developed. As an addendum to this guide, we will be including a chapter on Dashboards as well as working with uploaded spreadsheets.

Questions?

Please feel free to email me directly, [leaht@princeton.edu](mailto:leaht@princeton.edu) or [cedar@princeton.edu](mailto:cedar@princeton.edu).